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Introduction

Welcome to the Meridian 861 Reference Digital Surround Controller!

This User Guide provides full information about using the Surround

Controller in conjunction with your other equipment, to achieve the

superb results you can expect from it.

OffDSP MuteSourceReference Digital Surround Controller 861
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INTRODUCTION

The 861 Reference Digital Surround
Controller

Digital signal processing, or DSP, is a technique pioneered by Meridian in
hi-fi products for achieving extremely accurate reproduction of audio
signals. Unlike conventional analogue systems – which process signals using

electronic circuits based on resistors, capacitors, and inductors – DSP works
by performing exact mathematical calculations on digital versions of the
signals.

The advantage of DSP over analogue circuitry is that the signals are held as
precise numbers, rather than voltages in a circuit. This means that any

number of stages of processing can be performed with high precision, and
without any of the cumulative noise or degradation that inevitably occurs,
even with high-quality analogue circuitry. In addition, several of the

surround-sound decoding techniques and signal improvement techniques
available in the 861 would be virtually impossible to implement in
analogue circuitry.

At Meridian we have taken advantage of the availability of high speed DSP
microprocessors to incorporate DSP in hi-fi products, and the 861 is the

result of several years of our research and development in this field.

The 861 takes advantage of DSP for several different functions:

• To de-jitter incoming digital signals and expand the precision of the
signal.

• To perform filtering or adjustment of the frequency response; eg treble

or bass.
• To decode digitally-encoded signals from Dolby Digital (AC-3), DTS, or

MPEG Audio.

• To process the audio into a multi-channel signal, and match the source
channels to the configuration of main loudspeakers and subwoofers in
the system.

The 861 converts analogue input signals to digital format, using high-
quality analogue-to-digital converters (ADCs). Digital signals, from CD,

DVD, LaserDisc or digital broadcasting, are already in digital format and do
not need to be converted.

The signals are then retained in digital form throughout the 861 until they
are converted back to analogue form at the analogue outputs, to drive
power amplifiers. If you are using the 861 with Meridian DSP Loudspeakers,

the signals remain in digital form until the last possible stage.
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DSP presets

The 861 provides an extremely comprehensive range of options for

decoding both analogue and digital audio signals and processing them for
multi-channel reproduction.

The Digital Surround Controller provides several digital signal processing
options, called DSP presets, and these are designed to provide the best
results with a range of different types of music and film material.

In addition to selecting built-in DSP presets, the Digital Surround Controller
allows you to create your own presets based on the standard ones. For

example, you may want to add more delay to the rear speakers to create a
more spacious sound. You can store your modified preset with a name of
your choice, and recall it for use at a later date.

This section gives information about each of the built-in DSP presets, and
gives recommendations for the best preset to choose for different types of

material.

Multi-channel digital sources

Several alternative multi-channel digital formats are currently available

which encode up to 8 different channels onto a digital signal. Four
alternatives are currently in use: Dolby Digital, DTS, MPEG Surround, and
MLP. However, the 861 has been designed so that it can be upgraded by
downloading a software update, to cater for new formats as they are

introduced.

Dolby Digital
Dolby Digital, previously called AC-3, is the preferred sound format for DVD
in NTSC territories, and is widely used on LaserDisc soundtracks. It is also
the audio standard for US digital television.

DTS
DTS uses a carefully-designed audio compression technique to encode five

channels of audio onto a digital signal. The DTS format is used to encode
multi-channel film soundtracks on LaserDiscs and DVD video discs.

In addition, a high data-rate version of DTS can be used to compress five
channels of CD-quality audio into the same space as two channels of
unencoded sound, allowing a DTS music CD to provide over an hour of five-

channel music, at a quality indistinguishable from conventional CD.

MPEG Surround
MPEG Surround is the preferred audio format for DVD in PAL territories,
and along with Dolby Digital is a contender as the standard for music and
performance videos on DVD worldwide.
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THX
THX versions of Dolby Digital, MPEG Surround, and DTS are provided to

give a better match between the original soundtrack and typical domestic
listening conditions.

MLP
MLP (Meridian Lossless Packing) is an audio format that increases the
amount of information that can be recorded on a CD or DVD, without any

loss of quality.

Multi-channel sources encoded onto two channels

Several systems have been developed for encoding multi-channel sources

onto a standard two-channel analogue signal so that they can be
reproduced by a conventional stereo system, or decoded with special
equipment for multi-channel reproduction. The 861 provides decoding of

the two most important of these, Ambisonic and Dolby Surround. Although
the channel separation cannot be as good as with the digital multi-channel
formats, the 861 produces excellent results with these formats.

Pro Logic
The Pro Logic preset is recommended for decoding Dolby Surround

encoded video and LaserDisc soundtracks, and films on television. Such
materials are usually identified by a Dolby Surround symbol on the
packaging, or displayed on the film before the programme.

TV Logic
TV Logic provides user-adjustable steering, and is recommended for use

with TV broadcasts that are not surround encoded, where Pro Logic may
give reduced intelligibility.

THX Cinema
THX Cinema enhances Pro Logic to replicate the sound of a dubbing
stage or theatre, whether or not the other equipment in your system is THX

approved.

Ambisonic
Ambisonic decodes material specifically encoded for surround sound
reproduction, using a two-channel stereo-compatible encoding. Recordings
encoded in Ambisonic format are available on CD from several sources

including Nimbus Records and York Ambisonic. Some radio broadcasts are
also broadcast in Ambisonic format.
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Conventional stereo sources

The Digital Surround Controller can also accept a conventional two-channel
source, such as music on compact disc or a video soundtrack, and by

analysing the information in the signal separate the two-channel recording
into multiple channels to give better reproduction and a more stable
spatial image.

Four alternative DSP presets are provided for reproducing material
originally designed for a conventional stereo pair of speakers, and the

choice of which preset to choose largely depends on your own personal
preferences.

All four presets use similar procedures to extract the surround component
of the original recording, which is delivered to the rear surround speakers,
and side surround speakers if present.

Music
Music uses a special technique developed by Meridian to divide the sound

between the left, right, and centre speakers and give a wide, spacious
sound. We recommend this option for large-scale music, such as orchestral
and choral music.

Trifield
Trifield uses a different processing technique to give a stable, three-

dimensional image, with the ability to adjust the width of the image.
Because of its precision we recommend this option for solo, chamber, or
vocal music.

Super Stereo
Super Stereo provides a form of Ambisonic decoding suitable for material

that is not specially encoded. We recommend this option for multi-miked
or multi-tracked music, such as rock music.

MusicLogic
MusicLogic provides user-adjustable steering to give an exciting sound
with many types of music. We recommend this option for studio-produced

music, ie material not produced using natural soundfield recording.
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Special DSP presets

The Digital Surround Controller also includes the following special DSP
presets, for specific applications:

Mono
The Mono preset is designed for reproducing mono materials through a

centre speaker, so that any high-frequency hiss or clicks are centrally
localised. It is intended for mono recordings, and multi-language LaserDiscs
and video soundtracks.

The Mono preset includes an Academy option, designed to correct for a
high-frequency balance in some old black and white films, and a Party
option, which plays the mono signal through all loudspeakers.

Stereo and Direct
Stereo and Direct are provided for comparison with the other DSP
presets. Direct uses just the main left and right speakers for traditional
two-speaker stereo reproduction. Stereo, in addition, uses any subwoofers

in the layout to enhance the bass or to protect small speakers.
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Overview

The architecture of 861 allows for wide flexibility – future sources and

formats can be handled by upgrading either software or cards.

Inputs

The 861 is a full-system controller preamp that provides seamless control of

up to 12 sources.

The optional Tape card provides additional internal 20-bit A/D and D/A

converters to give full support for both tape recorders, extensive 2- and
3-zone multi-room capability (analogue or digital formats), and
headphones.

By providing digital as well as analogue inputs the 861 can give radically
higher sound quality for sources that are originally digital – like CD,

LaserDisc, Digital Radio and DVD.

As well as accepting 2-channel digital audio, the 861 will handle SPDIF-

encoded Dolby Digital, DTS or MPEG from sources like DVD, Satellite and
LaserDisc (via an RF00 LaserDisc Demodulator Card).

Processing

The Meridian 861 routes all signals – if necessary via a 20-bit Delta-Sigma

A/D converter – into the digital domain for processing in the highly
developed Meridian 24-bit DSP cards.

This processing engine can consist of between 2 and 10 modular processor
cards, each housing 1 or 2 ultra-fast 24-bit processors with high-speed
cache memory. In each DSP core, the incoming signals are processed using a

variety of proprietary algorithms and up to 8 output signals are generated.
These output signals can be used to feed a number of speaker layouts,
ranging from 2-speaker to 7-speaker stereo with up to 8 Meridian digital

subwoofers.

The on-board algorithms include Meridian’s own highly transparent Dolby

Pro Logic and Dolby Digital, MPEG Surround, DTS, THX extensions, TV Logic
and a variety of award-winning music programs including Trifield and
Ambisonic.

Outputs

The 8+ outputs can be provided as digital signals to feed Meridian DSP
Loudspeakers, or as variable analogue outputs using a proprietary on-

board 24-bit resolution conversion method.
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Video control and OSD

The Meridian 861 provides broadcast-grade video switching options for
monitors, projectors and video tape routing. The comprehensive setup and

customising facilities allow the user to link any video and audio
combinations to the 12 Sources (accessed from Source switching on the
front panel or the remote control).

In addition to providing high-quality video amplification, the 861 has the
ability to give help and system control feedback information in an On-

Screen Display. Video formats supported include Composite, S, and
Component.
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Typical specification

Audio in and out

• Up to 12 analogue inputs. User-adjustable sensitivity. Re-nameable

legends.
• Up to 12 digital inputs. Re-nameable legends. 32 to 96kHz sampling, and

up to 24-bit precision.

• Digital and analogue tape loops.
• Independent copy and 2-room+ capability.
• 2 to 8 digital outputs.

• 2 to 8 analogue outputs.
• Optional 5.1-channel analogue input.

Control signals

• 3 trigger outputs, programmable by source.
• Meridian Comms and RS232 for control and setup.

Signal processing

The 861 uses Meridian’s proprietary DSP software to provide the following
powerful Modes:

• Pro Logic
• THX
• TVLogic
• Dolby Digital

• DTS Coherent Surround
• MPEG Audio and MPEG Surround
• Music

• Trifield
• Ambisonics
• Super Stereo

• MusicLogic
• MLP (Meridian Lossless Packing)

Controls, etc.

Front-panel facia controls for:

• Source, DSP, Mute, Volume and Off.
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Hinged control panel provides additional switches for:

• Display
• Copy
• Store and Assign

• Parameter menus
• Setup

Display

• 20-character dot-matrix display: adjustable brightness and contrast.
• Lights for Dolby, Digital, THX, DTS, and MPEG.
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Using the 861 Reference Digital Surround

Controller

This chapter provides a summary of the functions of the 861 Reference

Digital Surround Controller to identify the controls which you use to

operate the unit.

It also provides step-by-step instructions for operating the Digital

Surround Controller, using either the front panel or the Meridian

System Remote.
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SURROUND CONTROLLER Front panel keys

OffDSP MuteSourceReference Digital Surround Controller 861

Calibrate

ConfigAssignStore

Menu

CopyDisplay

Display
Shows the 
current source, 
DSP preset, and 
volume

DSP
Changes the 
DSP preset 
selected for a 
source

Mute
Mutes or 
restores the 
sound

Volume 
down/up
Change the 
volume

Off
Switches to
standby

Source
Selects the 
source

Config
Selects the 
sinewave test 
signal

Display
Changes the 
information 
displayed on 
the front panel

Store
Stores the 
parameters for 
a preset

Menu keys
Allow you to
select and 
change DSP
parameters

Indicators
Show the 
current DSP 
processing 
mode

Indicators
Show the 
current DSP 
processing 
mode

Calibrate
Sets up the 
loudspeakers

Assign
Assigns the 
current DSP 
preset to the 
current source 

Copy
Copies a source 
to the tape 
output
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Subtitle

Off

EnterReturn

Function 0 Title

Chapter

Record

Slow

OSD

T

Angle Audio A-B Phase

Setup

Band

7 8 9

4 5 6

1 2 3

Menu Volume

Display MutePreset

Clear

Store

Repeat

CD RADIO LP TV TAPE 1 TAPE 2 CDR CABLE DVD VCR 1 VCR 2 LD

Menu keys
Allow you to select 
DSP parameters 
and change their 
values

Title/Chapter
For controlling a 
DVD Player

Preset
Changes the DSP 
preset.

Store/Clear
For programming 
DSP presets

Display
Changes the front-
panel display

Control keys
For controlling a 
CD Player, DVD 
Player, or Tuner

Number keys
For controlling a 
CD Player, DVD 
Player, or Tuner

Function
Hold down to 
select a secondary 
function, shown in 
blue below some 
keys

Volume keys/Mute
Change the volume

Off
Switches all Meridian 
equipment to standby

Source keys
Select a source

Meridian System

Remote keys
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REFERENCE DIGITAL

SURROUND CONTROLLER Switching on and off

When not playing, the Digital Surround Controller should be left in the

standby state. This uses a negligible amount of electricity, but ensures that
the components of the Digital Surround Controller operate at maximum
efficiency from the moment you start.

If you are not going to use the Digital Surround Controller for several days
you should switch the unit off completely at the rear panel, and disconnect

it from the AC power supply.

To switch on from standby

• Press Source (front panel), or select a source by pressing the appropriate

source key on the remote; eg CD.

If the Digital Surround Controller is part of a Meridian system it will

automatically switch on any other unit in the system, such as the 800
Reference DVD/CD Player and Meridian DSP Loudspeakers.

To switch to standby

• Press Off (front panel or remote).

If you have other Meridian equipment or Meridian DSP Loudspeakers
connected to the Digital Surround Controller these units will also switch to

standby.
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SURROUND CONTROLLER Selecting a source

The sound processor provides the following 12 sources:

CD, Radio, LP, TV, Tape 1, Tape 2, CDR, Cable, DVD, VCR1, VCR2,
LDisc.

The input and DSP preset associated with each source
depends on how the Digital Surround Controller has been

set up; for more information see Setting up sources,
page␣ 75.

To select a source

• Press Source (front panel) until the display shows the source you
require, or press the appropriate source key on the remote; eg CD.

The display shows the source, DSP preset, and volume setting.

For example, if you select

the CD source the display
might show: CD    Trifield    65

Your installer may have

customised the labels displayed for

each source to suit your other

equipment.

The Digital Surround Controller

mutes the sound while you

change source, to avoid clicks in

the speakers.
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REFERENCE DIGITAL

SURROUND CONTROLLER

A setting of 87 corresponds

to THX reference gain, the level

at which film soundtracks are

mixed.

Adjusting the volume

The 861 Reference Digital Surround Controller adjusts the volume in precise

steps of 1dB, where 9dB is equivalent to doubling the loudness. The
current volume setting is displayed in dB on the front panel

display, and can be varied in the range 1 to 99dB. When you

first connect power to the Digital Surround Controller the
volume is set to 65, which is similar to the mid-way position

of the rotary volume control on a conventional preamplifier.

For normal to high level listening you should expect to use volume
levels in the range 60 to 90.

To change the volume

• Press A or V (front panel), or the red A or V keys on the remote.

As you adjust the volume setting the display shows the current volume
level.

For example: CD   Trifield     70

To mute the sound

• Press Mute (front panel or remote).

The display will show: Mute

To restore the sound

• Press Mute again.

Alternatively, the sound will be restored if you adjust the volume.
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SURROUND CONTROLLER

In each case these will be followed by any user-defined presets you have
stored for the appropriate audio format.

To change the DSP preset

• Press DSP (front panel) or Preset (remote) to step between the
different DSP presets.

You will be able to choose any of the predefined DSP
presets, or any user-defined presets you have stored.

Audio format Presets

Two-channel (PCM or Direct, Music, Trifield, Ambisonic, Super, Stereo, MusicLogic,
2-channel Dolby Digital) ProLogic, THX Cinema, Mono, Academy, TV Logic

Dolby Digital Digital, Digital THX

DTS DTS, DTS THX, DTS Music

MPEG MPEG, MPEG THX, MPEG Music

MLP MLP

The Digital Surround Controller

mutes the sound while you

change DSP preset, to avoid clicks

in the speakers.

Changing the DSP preset

Each source has a set of DSP presets associated with it, one for each of the
alternative audio formats: two-channel (PCM), Dolby Digital, DTS, MPEG,
and MLP.

When you choose a source an appropriate DSP preset is selected for the
incoming audio format.

For example, if you have selected the CD source and are playing a
conventional CD, the Trifield DSP preset will initially be selected.

You may then wish to choose a different DSP preset, such as Music or
Ambisonic.

You can also change the default DSP preset assigned to the source; see To
assign a DSP preset to a source, page 32.

The sequence of DSP presets for each audio format is as follows:
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SURROUND CONTROLLER Changing the display

The 861 Reference Digital Surround Controller displays information about

the current settings on the 20-character front panel display. In addition, it
can display the same information superimposed on a video image.

You can adjust the contrast and brightness of the front-panel display for
optimum viewing, and choose what information is displayed.

The Digital Surround Controller automatically stores these settings, even
with the power off.

To change the contrast

• Press > or < (remote), or the corresponding Menu buttons under the
front panel, until the
display shows: CD    Contrast     8

• Press A or V (remote), or the corresponding Menu buttons under the
front panel, to change the display contrast.

You can change the contrast between 0 and 15.

To change the brightness

• Press > or < (remote), or the corresponding Menu buttons under the

front panel, until the
display shows: CD    Bright      11

• Press A or V (remote), or the corresponding Menu buttons under the
front panel, to change the display brightness.

You can change the brightness between 0 and 15.
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SURROUND CONTROLLER

Display option Example

Source, DSP preset, and volume
 CD   Ambisonics  65

DSP preset, source, and THX
reference level  CD   Ambisonics -22

Audio format and sampling rate
 CD   PCM        44k

Blank

To change the displayed information

• Press Display. TV     ProLogic

Each time you press Display the display will step between the options
shown in the following table.

If your Digital Surround Controller is fitted with a video card, the same
information can be displayed on an on-screen display.

For example:

You can choose the position of the on-screen display for each DSP preset;
see To change the position of the on-screen display, page 31.

If the Diagnostic display option has been selected additional diagnostic
displays are included; refer to the Meridian Web site at
http://www.meridian-audio.com for details.

http://www.meridian-audio.com
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Symbol What it means

Dolby processing is operating.

DIGITAL Input is Dolby Digital.

THX processing is operating.

Input is DTS.

MPEG Input is MPEG.

In addition, the following symbols on the front panel display indicate
which of the DSP processing modes are operating:
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SURROUND CONTROLLER Recording a source

The 861 Reference Digital Surround Controller allows you to copy any of

the standard sources to the tape outputs, independently of the source you
are listening to.

If you are using the Digital Surround Controller in a two-room system, you
copy a source to the tape output to make it available to the second room.

To copy a source

• Press Copy (remote or under the front panel).

Each time you press Copy the Digital Surround Controller will step

between the options shown in the table below.

For example, to record the DVD sound on a tape recorder:

• Press Copy until the display shows: Copy DVD

You can now listen to a different source, such as CD, by selecting the
source, without affecting what is being recorded.

Display Option

The current audio and video inputs are fed
 Copy Source to the tape/VCR outputs.

The tape and VCR outputs are muted.
 Copy Mute

Copies the first source to the tape and VCR
 Copy CD outputs.

Steps through each source in turn, etc.
 Copy Radio

To change the headphone volume

You can connect headphones to the Digital Surround Controller using the

optional Tape expansion card. The source copied to the tape output is also
fed to the headphones.

To change the headphone volume:

• Press Function with the red A or V keys on the remote.

The display will show the current
headphone volume; for example: Headphone Volume 65
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In addition to being able to change the source, volume, and DSP

preset, the 861 Reference Digital Surround Controller provides a

sophisticated range of more advanced adjustments for each DSP

preset, to allow you to tailor the sound.

This chapter explains how to change these parameters, and gives

detailed instructions for adjusting the parameters that are common to

most of the DSP presets.

For information about the parameters specific to individual presets see

DSP presets, page 35.

Customising the 861 Reference Digital

Surround Controller
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SURROUND CONTROLLER Locking and unlocking the menus

To simplify the normal operation of the Digital Surround Controller, and to

protect the settings from accidental changes, you can lock the menus so
that the DSP parameters cannot be accessed.

The only parameters available with the menus locked are Brightness and
Contrast.

To display or change the DSP presets, or to define your own presets, you
first need to unlock the Digital Surround Controller menus.

To unlock the menus

• Press Off (front panel or remote) to put the Digital Surround Controller
in standby.

• Press and hold down the Store button under the front panel for a few
seconds until the display
shows: Unlocked

To lock the menus

• Repeat the above sequence so that
the display shows: Locked
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SURROUND CONTROLLER Changing the DSP parameters

Each DSP preset provides a series of parameters that you can vary to
customise the behaviour of the preset to your specific requirements. For
example, most presets provide Balance and Depth parameters to allow
you to alter the characteristics of the sound.

For each of the built-in DSP presets these parameters are set to standard
values, designed to give the best sound in typical listening conditions and
with most source materials. Each time you select a different DSP preset the
parameters are reset to these standard values, even if you have previously
altered them.

You can save the changes you have made to one or more DSP parameters
in place of the original DSP preset. Alternatively you can create a new user-
defined DSP preset, with a name of your choice. User-defined presets
appear in the list of DSP presets after the built-in ones. For more
information about doing this see Defining your own presets, page 33.

Standard parameters

All DSP presets (except Mono, Stereo, and Direct) provide the following
parameters:

* These parameters apply to all DSP presets.

Parameter Range Default What it changes

Treble -10dB to +10dB +0.0dB The slope of the frequency response.

Bass -5dB to +5dB +0.0dB The bass response.

Phase* + or - + The phase of all loudspeakers.

Balance <10 to 10> <0> The L-R balance.

Centre -3.0dB to +3.0dB +0.0dB The level of the centre.

Depth -2.5ms to +5ms +0.0 The relative delay of the centre.

Rear -30dB to +10dB +0dB The relative level of the rears.

Sides -30dB to +10dB +0dB The relative level of the sides.

R Delay 15ms to 30ms 0.0 The relative delay of the rears.

S Delay 15ms to 30ms 0.0 The relative delay of the sides.

LipSync 0ms to 30ms 0.0 The sync. delay.

Contrast* 0 to 15 10 The front panel display contrast.

Bright* 0 to 15 10 The front panel display brightness.

OSD* Off, Low, Med, High Low The position of the on-screen display.
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SURROUND CONTROLLER Individual DSP presets provide additional parameters, to allow you to
adjust specific features provided by that preset. For full details refer to DSP
presets, page 35.

To change a DSP parameter

• Make sure the menus are unlocked; see To unlock the menus, page 24.

• Press > or < (remote) until the display shows the name of the parameter

you want to change.

For example: CD    Depth     +0.0

• Press A or V (remote) to change the value of the parameter.

Alternatively you can use the corresponding Menu buttons under the front
panel.

As you change the value you will be able to hear the effect on the sound,
and the display will show the current value.

After a short delay the display will revert to the normal display of DSP
preset and volume.
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SURROUND CONTROLLER Changing treble, bass, or phase

The Digital Surround Controller provides sophisticated treble and bass

controls, to allow you to adjust the broad balance of the system to correct
for the acoustics of your listening room, or for a misbalanced recording.

The controls are more subtle than conventional tone controls, and
take advantage of digital signal processing techniques to

provide a more natural adjustment of the frequency response.

You can also change the absolute phase of the signal, to
compensate for recordings which are out of phase.

In each case all the outputs of the Digital Surround Controller are
given the same frequency adjustment, to ensure a correct surround effect.

To change the treble

• Press < or > (remote) until the display shows the current treble setting.

For example: CD    Treble    +0.0

• Press A or V (remote) to change the treble.

The treble control tilts the frequency of the response over the entire
frequency range to make the sound more or less bright. It can be adjusted
between ±10dB in 0.5dB steps. Normally settings between +1.0 and -2.0 will

give the most natural results.

To change the bass

• Press < or > (remote) until the display shows the current bass setting.

For example: CD    Bass      +0.0

• Press A or V (remote) to change the bass.

The bass control allows you to adjust the bass response in the room by

±5dB in 0.5dB steps. Normally settings between +3.0 and -2.0 will give the
most natural results.

To change the absolute phase

• Press > or < (remote) until the display shows the current phase.

For example: CD    + Phase

• Press A or V (remote) to change the phase.

If you have a Meridian

DSP Loudspeaker the Treble and

Bass settings apply to all DSP

presets.
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SURROUND CONTROLLER Changing the listening position

A conventional stereo system provides a single balance control, which

changes the relative loudness of the two speakers. The 861 Reference
Digital Surround Controller provides a more sophisticated adjustment
which corresponds to moving the listening position to the left or right.

You can also change the level of the centre, side, or rear loudspeakers
relative to the main speakers.

To move the listening position to the left or right

• Press < or > (remote)
until the display shows: CD    Balance  <0>

• Press A or V (remote) to move the listening position.

The display shows the direction and position of the listening position.

For example: CD    Balance  <3

The arrow indicates the direction, and the number indicates the position
where 0 is central, 8 is in line with the corresponding main speaker, and 10

is fully to one side.

Note that this adjustment is not available for the Mono preset.

To change the relative level of the side or rear
loudspeakers

• Press < or > (remote) until the display shows the speaker(s) you want
to adjust; for example:

CD    Rear    +0dB

• Use A or V to change the relative level of the speakers, in dB.

You can change the relative loudness of the rear loudspeakers from -30dB
(about one-eighth of the loudness) to +10dB (about double the loudness).

For example, to double the loudness of the loudspeakers:

• Adjust their level until
the display shows: CD    Rear   +10dB

Note that this adjustment is not available for the Direct, Stereo, or Mono
presets.
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SURROUND CONTROLLER Changing the integration of the
centre

If you have a centre loudspeaker you can adjust its relative loudness, to
provide the best integration of the centre with the main left and right
speakers.

You can also adjust the relative delay of the centre speaker to give the best
perspective between the three front speakers.

Note that these adjustments are not available for the Direct, Stereo, or
Mono presets.

To change the relative level of the centre speaker

• Press > or < until the display shows the current centre level;
for example:

CD    Centre+0.0dB

• Press A or V to change the relative level of the centre speaker.

You can change the relative level by ±3dB.

To change the relative delay of the centre speaker

• Press < or > until the display shows the current centre depth;

for example:
CD    Depth     +0.0

• Press A or V to change the relative depth of the centre speaker.

You can change the depth between -2.5ms, which corresponds to moving

the centre speaker 2 Qw  feet nearer to the listening position, and +5ms,
which corresponds to moving it 5 feet further away from the

listening position.
Increasing the depth makes the

sound more open. Decreasing it

makes the sound more focused.
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SURROUND CONTROLLER Changing the spaciousness of the
sound

You can adjust the spaciousness of the sound by altering the delay on the
rear and side channels.

Note that these adjustments are not available for the Direct, Stereo,or
Mono presets.

To change the relative delay of the rear or side
speakers

• Press > or < until the
display shows: CD    R Delay    0.0

• Press A or V to change the relative delay of the rear speakers.

You can change the rear delay between 15ms, which is equivalent to
moving the rear speakers 15 feet away, and 30ms, which is equivalent to
moving the rear speakers 30 feet away.

If you have side speakers an additional S Delay option allows you to adjust
the delay on the side speakers between 15ms and 30ms.

The Dolby Digital, Music, Trifield, and Ambisonic
presets allow you to vary these delays down to 0ms.

For best results you should

never set the S Delay to be less

than the R Delay.
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SURROUND CONTROLLER Changing the lip sync and on-screen
display

To adjust the lip sync

The LipSync parameter is a unique Meridian feature which allows you to
adjust the delay between the sound and the video image by up to one
video frame.

Most movies are mixed for a viewing distance of 30 feet, and when viewed
from 12 feet or less the sound arrives too early, giving a disconcerting
effect. Using the LipSync parameter you can add an overall delay to the
sound to accommodate your closer home viewing distance.

Many TV broadcasts delay the picture by half a frame, and can benefit from
a LipSync setting of 12ms.

• Press > or < until the
display shows: CD    LipSync  0.0

• Press A or V to change the delay in milliseconds.

You can adjust the delay between 0 and 30ms, where 30ms corresponds to
sitting 30 feet further away from the screen.

If your video display system has a long latency, this can be corrected using
the source’s video frame delay option; see To set the advanced source
options, page 78.

To change the position of the on-screen display

For each DSP preset you can specify the position of the on-screen display
(OSD), or blank the on-screen display altogether.

For example, you may prefer to have the on-screen display at the top of the
screen when watching videos, but at the bottom of the screen when
listening to music.

• Press > or < until the display shows the current OSD position.

For example: CD    OSD        Low

• Press A or V to change the position.

You can choose between Off, Low, Med, or High.
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SURROUND CONTROLLER Changing the DSP preset for a
source

Each source has an appropriate DSP preset associated with it for each music
format. For example, for a standard stereo (PCM) signal the CD source uses
Trifield and the TV source uses TV Logic.

This section explains how to change the DSP preset associated with any
source.

To assign a DSP preset to a source

• Make sure the menus are unlocked; see To unlock the menus, page 24.

• Select the source you want to change by pressing the Source key on the
front panel or the appropriate source button on the remote, eg CD.

• If necessary, select a signal in the appropriate format. For example, to
change the DSP preset used for DTS compact discs, play a DTS CD.

The display will show the source and the DSP preset currently assigned to
that source.

For example: CD    Trifield    65

• Press A or V until the display shows the new DSP preset you want to
assign.

For example: CD    MusicLogic  65

• Press the Assign button to save the new assignment.
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SURROUND CONTROLLER Defining your own presets

The 861 Reference Digital Surround Controller allows you to modify one of
the built-in presets, and save it for future use.

You can either save the changes to the built-in preset, or you can create up
to 12 presets of your own, with names of your choice, so you can use them
alongside the built-in presets.

To save the preset settings

• Make sure the menus are unlocked; see To unlock the menus, page 24.

• Press DSP (front panel) or Preset (remote) to select the preset you want
to modify.

• Change the preset parameters to the values you want to store; see To
change a DSP parameter, page 26.

• Press Store (remote or under the front panel).

The display shows the next available user-defined preset.

For example: CD    User 1

• If you want to overwrite an existing user-defined preset press A or V to
select the preset you want to overwrite.

For example: CD    Classical

Alternatively you can choose the built-in preset you started with.

For example: CD    Trifield

• Press Store on the remote.

The settings have been stored in the new or existing preset you selected.

If you are defining a user preset you can now edit the name of the preset if
you wish.

A flashing cursor shows the
letter you are editing: CD    •ser 1
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SURROUND CONTROLLER If you have an on-screen display it shows:

• Press > or < to select the character position you want to edit.

• Press A or V to change the character.

Each press steps through the sequence A to Z, a to z, 0 to 9, full stop, and
blank. You can also select a blank directly by pressing Clear on the remote.

For example, you could
change the name to: CD    La Scala

• When you have entered the name you want to use press Store.

The display shows: Stored

To clear a user-defined preset

• Make sure the menus are unlocked; see To unlock the menus, page 24.

• Press DSP (front panel), or Preset (remote) to select the preset you want
to clear.

• Press and hold down Clear (remote) for several seconds.

The display shows: Preset Clear

If you clear a preset that was saved over a built-in preset, the original
preset name and settings are restored.
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DSP presets

This chapter gives technical information about each of the DSP presets

built in to the 861 Reference Digital Surround Controller.

It explains the processing performed by each DSP preset, and gives

details of the types of material you should use with each preset.

It also gives details of the special DSP parameters available for each

preset.

The DSP presets are divided into three categories: Logic, Music, and 5.1

Movie. You can set up the Digital Surround Controller to use a

different subwoofer configuration for each category of DSP preset.
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Logic DSP presets

The Digital Surround Controller provides five DSP presets specifically

designed for reproducing film soundtracks. Three of these presets, Pro
Logic, THX Cinema, and TV Logic, are designed for Dolby Surround
encoded material. Most films, and many TV programmes and series, are

encoded using Dolby Surround, and it is increasingly being used to encode
music.

The 861 Reference Digital Surround Controller follows the Meridian
philosophy of performing all the signal processing digitally, and the Dolby
Surround decoding operates purely in a digital mode. This gives it a far

higher performance and a better subjective sound than other analogue-
based decoders.

The remaining Logic preset, Mono is designed for films with mono
soundtracks.

Pro Logic

Dolby Surround is an encoding system based on a phase-amplitude matrix
whose output can be decoded by a very simple passive matrix. Such a
decoder gives quite a poor separation.

The Pro Logic system uses psychoacoustically optimised directional
enhancement to increase the separation in both left-right and front-back
directions. It does this by continuously calculating the position and degree

of the currently-dominant sound. This sound is then steered to a greater or
lesser extent to that position in the arriving sound. This technique is very
successful for cinema and other dramatic programmes.

Further refinements in the Pro Logic decoder include the filtering and delay
of the rear surround signal to reduce any tendency for the surround signals

to divert attention or become dominant. The Pro Logic decoder also uses a
modified digital Dolby noise-reduction process in the surround signal. Since
Dolby Surround material is encoded with this in mind the noise-reduction is

permanently operating in this mode.



37

DSP PRESETS

THX Cinema

The THX Cinema DSP preset provides Pro Logic decoding, followed by
additional signal processing refinements developed by Lucasfilm Ltd.

The THX extensions to Pro Logic decoding are designed to provide a better
match between the sound of the movie theatre and a home cinema in the
following ways:

• The front channels are re-equalised to correct for the higher treble
often found in film soundtracks.

• The surround channels are frequency-corrected using a timbre-matching
process so that sounds moving front–back are more convincing.

• The surround channels are decorrelated to break up any artificial
localisation of the rear signals due to the speakers being nearby. In the
861 Reference Digital Surround Controller this decorrelation is optimised
to give spacious surround sound that has no artefacts disturbing to
music or other sensitive sounds in the mix.

• The time synchronisation between loudspeakers is adjusted to
compensate for the fact that the speakers in a home system tend to be a
lot closer to the listener than in a movie theatre.

THX can also be used with the 5.1 Movie DSP presets; see Dolby Digital
THX, DTS THX, and MPEG THX, page 43.

Pro Logic and THX Cinema DSP preset parameters

Parameter Options What it changes

Mono Rear Steered Rear, Steered Side, Which of the surround channels are
Steered All, Mono All, generated by steering. Mono gives
Mono Rear, Mono Side conventional Pro Logic surrounds. Steered

gives stereo surrounds.

TV Logic

TV Logic is a logic preset, with user-adjustable steering, that can give
higher intelligibility and a more appropriate spatial presentation for
studio-based TV material.
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TV Logic DSP preset parameters

Parameter Options What it changes

Roll Off, Low, Med, High The degree of left-right steering.

Yaw Off, Low, Med, High The degree of front-rear steering.

Mono Rear Steered Rear, Which of the surround channels are
Steered Side, generated by steering.
Steered All,
Mono All, Mono
Rear, Mono Side.

Mono

In the Mono DSP preset you can choose to listen to:

• Only one of two input channels, such as when different languages or
material are carried on each channel.

• A combined version of the two input channels, such as if the material
was originally mono and has been conveyed on a two-channel carrier.

If Party? is set to No, the combined or selected signal is played only through
the centre speaker, or the left and right speakers if there is no centre, to
centrally localise high-frequency hiss and clicks.

Note that if Party? is set to Yes, full range bass is played through any
speakers that are not supplemented by a subwoofer, and this may damage

small speakers at high volume levels.

Mono DSP preset parameters

Parameter Options What it changes

Input Auto L+R, Input L, The channel selected.
Input R, Input L+R

Academy Off or On Select On to include an equalisation
(recommended by Lucasfilm Ltd) to correct
for a high-frequency balance in some old
mono films. Ignored if Party? is set to Yes.

Party? No or Yes Select Yes to play the mono signal through
all speakers, including subs.



39

DSP PRESETS

Music DSP presets

The Digital Surround Controller provides seven alternative music DSP

presets designed for the reproduction of well recorded material, originally
intended for replay over a traditional stereo pair of loudspeakers.

In addition, it provides DSP presets for reproducing music in the digitally
encoded DTS, MPEG, and MLP formats.

Music format Presets

Conventional stereo (PCM) Direct, Music, Trifield, Ambisonic, Super, Stereo,
Music Logic

DTS DTS Music

MPEG MPEG Music

MLP (Meridian Lossless Packing) MLP

Music

The Music DSP preset extracts the mono and surround components of the

original recording. These components provide an alternative
representation of the original sound, and this representation is sometimes
used for recording systems or in broadcasts such as FM radio.

The mono element is equalised using a proprietary Meridian technique to
match the tone colour of the centre speaker, and to compensate for the
fact that the frequency response of human hearing changes with direction.

The Music DSP preset is recommended for recordings made with spaced
omnidirectional microphones, or using a mono-surround technique.

Trifield

As for the Music DSP preset, the Trifield preset extracts the mono and
surround components of the original recording. It then calculates the

signals for the front left, centre, and right speakers, using the phase and
amplitude differences between the three front channels, to redistribute the
sounds on a frequency-dependent basis.

This gives a significant improvement over traditional stereo, which converts
the differences between the microphone signals into amplitude differences

in the speaker signals. This version of the Trifield algorithm is virtually
impossible to implement without digital signal processing.
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Trifield is recommended for well-made recordings and stereo television
broadcasts that are not Dolby Surround encoded. An advantage over the

Music DSP preset is that the front stereo image is more focused, and the
width of the image can be adjusted.

Music and Trifield DSP preset parameters

Parameter Options What it changes

HS Out?* Y or N Select Y for high-rate audio to the front
speakers (left, right, centre, and subwoofer)
upsampled if necessary. Select N for
standard-rate audio using all speakers,
downsampled if necessary.

Centre Flat, EQ1–3 The timbre of the centre loudspeaker.

Width† 0–1.5 The width of the image.

Surr. Rear Surr. Rear, Surr. Side, Switches the surround signal between the
Surr. All side and rear speakers.

R Filter Off, 1kHz, 3kHz, The cutoff of high frequencies from the rear
7kHz surrounds.

S Filter Off, 1kHz, 3kHz, The cutoff of high frequencies from the side
7kHz surrounds.

* Only available with compatible hardware; contact your Meridian dealer.
† Trifield only.

Ambisonic

The Ambisonic DSP preset is designed for replaying material encoded in
UHJ format, the two-channel stereo-compatible encoding found on

Ambisonically-recorded discs and broadcasts. This material is specifically
encoded for surround reproduction and can give breathtakingly realistic
sound when replayed using the Digital Surround Controller.

Ambisonic surround sound is quite unlike conventional stereo. A special
microphone technique picks up the sound of the original performance in

all three dimensions, allowing an archive to be made which describes the
sound field exactly at that position. The microphone signals are then
encoded using a phase-amplitude matrix to allow the effect to be conveyed

on two-channel carriers (like FM radio, LP, or CD).

The Digital Surround Controller uses accurately matched, frequency-

dependent, phase-amplitude matrices to decode the signal and construct
the signals for each speaker feed.

The fundamental difference between Ambisonic surround sound and
conventional stereo is that the signals from all the speakers combine to
produce a coherent sound field at the listening position, giving the illusion
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that you are sitting inside the recording space whether you are at the exact
central seat or well off to one side.

Of all the signal-processing options, Ambisonic is the one that requires
the greatest attention to speaker choice and positioning.

Super Stereo

Super Stereo synthesises a signal from a conventional stereo recording or
broadcast so that it can be decoded using the Ambisonic decoder. The

result is especially effective for two particular types of recordings:

• Those using true coincident microphone techniques.

• Multi-tracked or multi-miked recordings.

Ambisonic and Super Stereo DSP preset parameters

Parameter Options What it changes

Width* 0 to 1 The width of the image.

Position† A, C, E, G, I, K, M The seating position; the letters are like rows
in a hall.

5 Channels 7, 6, 5, 4 The number of speakers.

R Filter Off, 3kHz, 7kHz, The cutoff of high frequencies from the rear
9kHz surrounds.

S Filter Off, 3kHz, 7kHz, The cutoff of high frequencies from the side
9kHz surrounds.

* Super Stereo only.
† Ambisonic only.

Music Logic

Music Logic is a music DSP preset with user-adjustable steering, designed
to provide an exciting experience with many types of studio-produced

music.

Music Logic DSP preset parameters

Parameter Options What it changes

Roll Off, Low, Med, High The degree of left-right steering.

Yaw Off, Low, Med, High The degree of front-rear steering.

Mono Rear Steered Rear, Which of the surround channels are
Steered Side, generated by steering.
Steered All,
Mono All, Mono
Rear, Mono Side.
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DTS Music

DTS Music is a special version of the DTS preset designed with a lower LFE
level of -10dB to match the bass levels applied to DTS music CDs.

MPEG Music

MPEG Music is a special version of the MPEG preset designed for listening
to MPEG encoded music CDs.

MLP

MLP (Meridian Lossless Packing) is an audio format that increases the
amount of information that can be recorded on a CD or DVD, without any
loss of quality.

For details of the DTS Music, MPEG Music, and MLP DSP preset
parameters see 5.1 Movie DSP preset parameters, page 44.

Stereo and Direct

The Stereo preset passes the left and right input signals directly to the left
and right main speakers. Any mono or front left and right subwoofers
continue to be used.

With the Direct preset only the left and right main speakers are used.

Stereo and Direct DSP preset parameters

Parameter Options What it changes

HS Out?* Y or N Select Y for high-rate audio to the front
speakers (left, right, centre, and subwoofer)
upsampled if necessary. Select N for
standard-rate audio using all speakers,
downsampled if necessary.

* Only available with compatible hardware; contact your Meridian dealer.
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5.1 Movie DSP presets

The discrete digital formats can encode up to eight separate channels,

which can be decoded to provide separate signals to the eight speakers in a
surround configuration.

Dolby Digital

Dolby Digital is a totally digital format capable of encoding five full
frequency-range channels, together with one restricted frequency-range
channel used for extreme bass.

The Digital Surround Controller’s Dolby Digital preset is capable of
decoding the range of different options provided by Dolby Digital. In

addition, it provides bass power management to protect systems from the
potentially high bass levels that Dolby Digital can produce.

Dolby Digital THX

As with the standard THX Cinema DSP preset, Dolby Digital THX re-
equalises the signals to suit domestic listening conditions, and applies
frequency-response correction and decorrelation to the surround channels

to make the surround sound more realistic, and can be used whether or not
your other equipment is THX approved.

DTS

DTS is unusual among the compressed surround formats in that it can

deliver high quality music at high bit rates.

CDs, DVDs, and LaserDiscs are currently available which provide a DTS

signal in place of the normal digital audio.

MPEG

MPEG surround is the preferred audio format for DVD in PAL territories.

Dolby Digital THX, DTS THX, and MPEG THX

As with the standard THX Cinema DSP preset, Dolby Digital THX, DTS
THX, and MPEG THX re-equalise the signals to suit domestic listening

conditions, and applies frequency-response correction and decorrelation to
the surround channels to make the surround sound more realistic, and can
be used whether or not your other equipment is THX approved.
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5.1 Movie DSP preset parameters

Parameter Options What it changes

Surr. Rear Surr. Rear, Surr. Side, Switches the surround signal between the
Surr. All side and rear speakers.

LFE 0 to -30dB The relative level of the LFE bass channel.

Max SPL* 105 to 120dB SPL The peak-level limit for an LFE subwoofer.

Limit* -15 to -5dBFS The peak-level limit of the total bass signal
added to the main speakers.

Compress† Off, Low, Med, The dynamic range control; see below.
Top, Max, Mix

* Dolby Digital and Dolby Digital THX only.
† See Using peak-level limiting, page 45.

Using dynamic range control

Because Dolby Digital is a digital format it allows dynamic range control
without the distortion involved in analogue methods. The Compress
parameter allows you to set one of the following options:

Option Description

Off No compression.

Low Provides a moderate amount of bottom-up compression. This raises quiet
sounds above the background noise, which is ideal for demonstration and
quiet listening.

Med Provides moderate amounts of both bottom-up and top-down
compression.

Top Provides a moderate amount of top-down compression. This reduces loud
sounds.

Max Provides full bottom-up and top-down compression. Quiet sounds are
raised to be audible and loud passages are minimised to avoid
disturbance, which is useful for late-night listening.

Mix Bypasses dialogue normalisation and references the sound pressure level
in the studio where the material was mixed.
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Using peak-level limiting

The Max SPL or Limit parameters allow you to set up peak-level limiting
for bass signals, and the setting applies to all the discrete digital DSP

presets.

If your loudspeaker layout includes one or more subwoofers the parameter

is named Max SPL, and it sets the peak-level limit for the LFE channel.

If your loudspeaker layout contains no subwoofer the parameter is named

Limit, and it sets the peak-level limit of the bass signal added to the main
loudspeakers. For loudspeaker layouts using Meridian DSP loudspeakers as
the main left and right, or centre speakers, the Limit value is fixed at

-11dBFS and the parameter does not appear in the menu.

Multi-channel presets

The IA40 multi-channel analogue input card provides 5.1 channel discrete

multi-channel inputs to the 861. This allows you to connect a source such as
a DVD-Audio player or film projector with multi-channel analogue outputs.
If such an input has been selected, then two built-in presets are available:

Discrete and Ambisonic.

The Discrete preset treats the inputs very much like 5.1 channel

compressed sources; for example the same dynamic bass limiting is used to
protect the speakers. The menus are the same as for the DTS preset with
the addition of an extra LFE Cut? parameter, which allows an analogue

10dB cut to be applied to the LFE input. This is useful for some discrete
music material which has the LFE channel recorded 10dB higher than the
LFE level of standard 5.1 movie material.

The Ambisonic preset allows B Format Ambisonic devices to be connected
to the IA40 with B Format automatically selected rather than the UHJ

format normally used on Ambisonic CDs.
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Configuring the Digital Surround Controller

without a computer

The 861 Digital Surround Controller can be set up for most standard

configurations of loudspeakers and sources using just the front-panel

controls and Meridian System Remote.

This chapter explains how to configure the Digital Surround Controller

without using a computer, and then how to calibrate the loudspeakers

and sources for your particular system.

Alternatively, for complete control over all aspects of the Digital

Surround Controller’s configuration you can set up the unit from a

computer using the Meridian Configuration program. For full

information refer to the next chapter.
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WITHOUT A
COMPUTER Choosing a standard setting

The Digital Surround Controller provides six standard settings, called Types,

which configure all aspects of the 861 into the most commonly needed
configurations. In addition, any User Types you create using the Meridian
Configuration program are also available.

Types 0 to 5 are factory settings, designed to cater for the most commonly
needed configurations of associated equipment.

These standard Types are shown in the following table:

In this table Music Sub refers to a subwoofer used for all Music DSP presets,
Logic Sub to a subwoofer used for all Logic DSP presets, and 5.1 Movie Sub
to a subwoofer used for all 5.1 Movie DSP presets.

Choosing one of the Types overrides any other configuration you may have
performed, and so can be used to reset the configuration of the unit. Note

that selecting a Type will clear any configuration and calibration changes
you have made, or any DSP presets you have defined.

If your Digital Surround Controller is fitted with a video card, and you have
a video source connected, the on-screen display also provides additional
text explaining about each Type.

To select a standard setting

Warning: this procedure will reset any configuration and
calibration changes you have made.

• Select a video source to produce an on-screen display.

• Put the Digital Surround Controller into Standby by pressing Off (front
panel or remote).

Type Music Sub Logic Sub 5.1 Movie Sub Speakers

0 None Centre LFE All analogue.

1 Mono Mono Mono All analogue.

2 None Centre LFE All digital.

3 None None None All digital, large centre.

4 None Centre LFE Digital left, right, and centre.

5 None Centre LFE Digital left and right.
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panel until the display shows: Type in... 3

• Keep holding down the A key for a further 3 seconds.

The display will show: Type- please wait.

If you have an on-screen display it shows:

Then after a short delay the display shows the current Type.

For example: Type   3

If you have an on-screen display it shows information about the Type; for
example:

• Press A or V on the front panel to change the Type number.

The display shows: Typing, please wait.
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• Wait for one second, and then put the Digital Surround Controller into
standby by pressing Off (front panel or remote).

• Switch on again to use the standard settings you have selected.

Setting up the Digital Surround Controller with other
Meridian equipment

If you are using the 861 with other Meridian equipment, such as the 800
Reference DVD/CD Player, you should set up the Comms with the following

automatic setup procedure:

• Switch all the units to standby.

• Press Clear (remote).

Each unit will display: Auto Setup

The 861 will then be designated as

the controller, and display: Controller

This is the unit that will respond to the remote.

All the other units will be configured
as non-controllers, and display: Not Controller

Your system is now set up and ready for use.

• If for any reason the automatic setup does not give the configuration
you want, restore the default operation by selecting one of the standard
Types; see Choosing a standard setting, page 48.
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To help you to set up your installation to give the best possible sound with

any particular combination of associated equipment, the 861 Reference
Digital Surround Controller includes a built-in calibration procedure.

This calibration procedure uses test signals to present a series of sounds,
which you use to adjust certain aspects of the system to their optimum
settings.

You should work through the calibration procedure the first time you set
up your surround sound system, and whenever you want to check the

calibration, such as after changing the layout of your room.

Using the calibration procedure

We recommend that you perform the calibration procedure using the

Meridian System Remote and from the listening position.

As you run the calibration procedure the name of each calibration test is

shown on the front panel display, followed by the parameters adjusted in
the test.

If your Digital Surround Controller is fitted with a video card, and you have a
video source connected, the on-screen display also provides additional text
explaining what to do.

Each calibration test uses a test signal designed to give the best results.

Using a Sound Pressure Level meter

Although you can perform the calibration procedure by ear, it is

recommended that you perform the tests using a Sound Pressure Level
meter, available fairly cheaply from Tandy/Radio Shack, or your Meridian
dealer may be able to lend you one.

Set the Sound Pressure Level meter to C weighted, and Slow. Take readings
with the meter at the listening position, pointing vertically. You should

hold the meter with an outstretched arm to minimise reflections from your
body.

To start the calibration procedure

• Put the Digital Surround Controller into standby by pressing Off (front
panel or remote).

• Press and hold the Calibrate button, under the front panel, for at least
five seconds.
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If you have an on-screen display it shows:

After a few seconds the
display shows: Left   Level  +0.0dB

For more detailed information about this and the other calibration tests
see the following sections.

To move between the calibration tests

• Press > (remote), or the corresponding Menu button under the front
panel.

• Press < (remote), or the corresponding Menu button under the front
panel, to move back to an earlier test.

To jump to the next set of tests

• Press Store.

The calibration tests are described in the following sections.

To exit from the calibration procedure

You can exit from the calibration procedure at any time, and any
parameters you have set will be retained.

• Press Off (front panel or remote).
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Levels

These tests allow you to adjust the output level to each speaker

individually, and it follows the general guidelines from Dolby Laboratories
and Lucasfilm. A Sound Pressure Level (SPL) meter can be useful at this
stage; ask your dealer for more information.

In each test the display shows the speaker being tested, and the current
relative level.

For example: Left   Level  +0.0dB

If you have an on-screen display it shows:

• Use the > and < keys to move between each of the speakers in the

layout in the sequence: Left, Centre, Right, Side R, Rear R, Rear L, Side L,
and subwoofers.

• Use A and V to adjust the level of the speaker. Ignore any tonal
difference.

For correct THX reproduction you should adjust each speaker to
75dB SPL using an SPL meter. Even if your speakers are not THX
approved this setting is recommended.

Note that you cannot set the level of a subwoofer by ear,
because low-frequency noises sound quieter. To set the

subwoofer correctly either use an SPL meter, or set it by ear and then
reduce the subwoofer gain by 15dB to correct for human hearing.

• When you have completed the Levels section press > or Store to
proceed to the next test.

If you have Meridian DSP

loudspeakers they cannot

be set above +0dB.



54

CONFIGURING
WITHOUT A
COMPUTER Distance

These tests allow you to adjust the delay of each of the speakers in the
layout to time-align the system so that sounds are coincident when they

arrive at the listening position.

Before setting up the speaker outputs you need to measure the distance, in

feet and inches, to each speaker from the listening position:

CentreSubLeft Right

Left
Side

Right
Side

Left Rear Right RearSurround Sub

Measure from the ear height at the listening position to the tweeter on
each speaker (where applicable).

• Use the > and < keys to move between each of the speakers in the
layout.

The display shows the speaker being tested, and the distance in feet.

For example: Left   Distance 18'0

If you have an on-screen display it shows:

• Use A and V to change the distance, in feet.
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• Press > or Store to proceed to the next calibration stage.

Fine tuning

These tests allow you to fine-tune the phase and delay of each speaker

when used in conjunction with other speakers on the layout.

• Use the > and < keys to move between each of the speakers in the

layout.

The first display allows you to adjust the phase.

For example: Left   Phase       +

If you have an on-screen display it shows:

The next display shows the distance (or delay) for the same speaker.

For example: Left   Distance 18'0

If you have an on-screen display it shows:
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Setting What it sounds like

Correct The sound between the speakers is very even, and does not change
radically as you move your head.

Incorrect The sound appears diffused, and changes in timbre and apparent location
as you move your head.

Pay particular attention to the centre channel, as this can have a dramatic
effect on the overall sound.

As you increase the delay the speaker will appear to move away from you.

You have now completed the calibration of your system.

• Press Off (front panel or remote) to exit from the calibration procedure.
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This section explains how to use Gain/Sub mode to set up the sources

connected to the Digital Surround Controller, and configure them to suit
your other equipment.

You can also adjust the subwoofer crossover frequency to suit the
subwoofers in your system.

To turn on Gain/Sub mode

• Put the Digital Surround Controller into standby by pressing Off (front
panel or remote).

• Press and hold the Config key under the front panel for at least five
seconds.

The display shows: Gain/Sub On

The Digital Surround Controller will then return to standby with Gain/Sub

mode turned on.

Gain/Sub mode adds two extra options to the DSP parameter menus:

Sensitivity and Xover.

To turn off Gain/Sub mode

• Repeat the above procedure until
the display shows: Gain/Sub Off

To adjust the sensitivity of a source

To obtain the best signal-to-noise ratio for your analogue sources you can
adjust the sensitivity of each input to give the highest level that does not

produce clipping.

• Turn on Gain/Sub mode, as described above.

• Select the source you want to adjust, with loud source material playing.

• Press < or > (remote or under the front panel) until the display shows
the current sensitivity.

For example: Radio 2.0V In

• Press A or V (remote or under the front panel) to change the sensitivity.



58

CONFIGURING
WITHOUT A
COMPUTER You can select between sensitivities of 0.5V (most sensitive), 1.0V, 2.0V, or

2.5V (least sensitive).

If the sensitivity is set too high the input will clip the loudest passages.

The display shows, for example: Radio 0.5V In Clip

In this case reduce the sensitivity.

If you have selected a digital source you cannot adjust the sensitivity.

The display shows, for example: CD    Not Analogue

To adjust the subwoofer crossover frequency

The Digital Surround Controller allows you to adjust the crossover

frequency of any subwoofers between 30 and 150Hz. The crossover can be
set independently for Music, Logic, and 5.1 Movie presets. The default is
the THX standard of 80Hz.

• Turn on Gain/Sub mode, as described above.

• Press < or > (remote or under the front panel) until the display shows
the current crossover frequency.

For example: Radio Xover   80Hz

• Press A or V (remote or under the front panel) to set the crossover

frequency.

For THX loudspeaker systems you should leave the crossover setting at

80Hz.

80Hz is also the recommended setting for all movie listening. You may

prefer, however, to lower the crossover frequency for music if your main
speakers have good bass handling down to, say, 50Hz.
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The 861 Reference Digital Surround Controller includes a sinewave signal

test, to help you set the subwoofer crossover frequencies, or check for
room resonances.

• Select a PCM source; eg an analogue source or CD.

• Press Config (under the front panel).

The displays shows: CD    Sine    80.0Hz

An 80Hz sinewave will be played through all channels.

You can change the test signal using the menu keys, as described in the

following sections.

To change the sweep rate

• Press < or > (remote or under the

front panel) until the display shows: CD    Pause   80.0Hz

• Press A or V to change the sweep rate and direction, as follows:

The sine sweep will stop when it reaches 0.5Hz or 200Hz.

To change the volume

• Use the volume keys in the usual way.

Warning: very loud low-frequency signals may damage speakers.

Display Description

Fast sweep up.
 CD        >>  88.5Hz

Slow sweep up.
 CD         >  81.5Hz

Paused.
 CD    Pause   80.0Hz

Slow sweep down.
 CD         <  78.5Hz

Fast sweep down.
 CD        <<  70.5Hz
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• Press < or > (remote or under the front panel) until the display shows
the current signal.

For example: CD    Sine

• Press A or V to choose between the following test signals:

Display Description

A sinewave.
 CD    Sine

Silence
 CD    Silent

The source signal in mono (left + right)
 CD    Input

Pink noise (band pass 500Hz to 2kHz for
 CD    Noise main channels).

To select the channel

• Press < or > (remote or under the front panel) until the display shows
the current channels.

For example: CD    All Channels

• Press A or V to select a specific channel, or All Channels.
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Configuring the Digital Surround Controller

using a computer

The 861 Reference Digital Surround Controller provides a flexible

range of customisation options which you can change to suit your own

preferences and the other equipment in your system.

This chapter explains how to install the Meridian Configuration

program, and use it to create your own configurations of the

Digital Surround Controller.



62

CONFIGURING
USING A COMPUTER

The Meridian Configuration
program

The Meridian Configuration program is a stand-alone Windows-based
application that lets you design your own configuration of each 800 Series
product to suit your own personal preferences, and the particular

configuration of other equipment in your system.

The Meridian Configuration program provides the following sections to

allow you to control the corresponding aspects of each 800 Series product’s
operation:

Setup
Lets you specify general features of the product’s operation,
including the position of the on-screen display, the information

provided on the front-panel displays, the startup volume, and
settings affecting its operation in multi-room systems.

Speakers
Lets you configure the product’s outputs to suit the type of
each amplifier and loudspeaker in your system, and if

appropriate the layout of the loudspeakers, to ensure that you
get perfect surround sound performance.

Presets
Lets you customise the settings of the built-in DSP presets, and
create additional presets of your own based on the built-in
presets.

Sources
Lets you customise the operation of each of the sources,

including the presets used by each source for each of the audio
formats, the digital, analogue, and/or video inputs used for that
source, and additional information about the type of each

source.

Cards
Displays information about each of the cards in the product,
and lets you change the configuration of a card, and add or
remove cards.
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Installing the Meridian
Configuration program

Requirements

To use the Meridian Configuration program you need:

• A computer running Windows 95 or Windows NT 4.

• A 100MHz or faster Pentium-class processor.
• At least 16 Mbytes of RAM.
• 5 Mbytes of free disk space.

• A vacant 9-pin serial port assigned to one of COM1 to 4.

The software requires a mouse or similar pointing device – it cannot be

operated solely from the keyboard.

To install the Meridian Configuration program

• Insert the first Meridian Configuration program installation disk.

• Choose Run... from the Start menu.

• Type A:  setup and press R.

• Follow the on-screen instructions, inserting the second installation disk
when prompted.

If you have an 800 Reference DVD/CD Player

If your equipment includes both an 861 Reference Digital Surround
Controller and an 800 Reference DVD/CD Player configure the DVD/CD

Player first as described in the corresponding chapter of the 800 Reference
DVD/CD Player User Guide.
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To run the Meridian Configuration program

• Click Start, point at Programs, then click Meridian Configuration.

The Meridian window will be displayed:

The toolbar provides a convenient way of accessing the most important
menu options:

Button Option Function

New Creates a new settings file.

Open Opens an existing settings file.

Save Saves the current settings file to disk.

Fetch Fetches the current configuration of the attached
product(s).

Store Stores the current settings and User Types to
attached products.

Disconnect Disconnects the program from attached products.

Add product Allows you to add a product to the settings file.

Copy Copies text or settings onto the clipboard.

Paste Pastes text or settings from the clipboard.

Print Allows you to print a copy of your settings.
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To connect the serial cable

The serial cable is symmetrical, and can be connected either way round.

• Connect one end to the RS232 connector on the COMPUTER card on the
back panel of the 861 Reference Digital Surround Controller.

• Connect the other end to one of the serial ports on the PC or PC
notebook computer.

Then specify the serial port you are using as follows:

• Choose Options from the View menu to display the Options dialogue

box:

• Select the port you want to use and click the OK button.
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Creating a new settings file

This section explains how to create a new settings file, using the Meridian

Configuration program, and how to enter personal information to identify
the settings in your product.

The first step is to fetch the initial settings from the Digital Surround
Controller, to use as a starting point for your configuration.

• Click the Fetch button in the toolbar.

The Progress dialogue box will show you the progress as the settings are

fetched:

A new settings file will be created for you, with the initial name MSF1, and
the Meridian window will show Surround controller icon to identify the

product you are configuring.

• Choose Save As from the File menu, enter an appropriate name for the
file and click the Save button.
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To display the settings

• Double-click the Surround controller icon, to open it and display the
settings it contains.

The left-hand panel of the Meridian window will change to show the
following four icons:

Owner lets you enter personal information, for future reference, and
choose the message displayed when you first switch the unit on, and
Settings is the initial configuration in the settings file.

Double-clicking Return to top level takes you back to the previous level.

To enter your personal details

• Click the Owner icon in the left-hand panel.

• Enter any text you like in the Dealer, Owner, and Description fields.

You can enter up to 20 characters in each field, the size of the DVD/CD
Player front-panel display.
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The Owner text will be displayed when you turn the product on. The
Dealer and Description text are displayed after the product version and
serial numbers if you hold down the front-panel Display key in standby.

The options on the Advanced tab are for use by a dealer in setting up a
multi-room system, and to upload a new version of the software to the

product, and it is recommended that you do not change these settings.

To display or edit the settings

• Double-click the Settings icon.

The Meridian window will change to show the five categories of settings
contained in the settings file: Setup, Speakers, Presets, Sources, and

Cards.

The options available in each case are explained in the following sections.

At this stage you may find it useful to maximise the Meridian window so
you can see all the options on each screen.
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Setting up speakers

This section describes how to use the Meridian Configuration program to

configure the 861 Reference Digital Surround Controller for the
configuration of loudspeakers in your system, and specify information
about the type of each speaker, for optimum performance.

The first stage in setting up the speakers is to specify the number of
speakers in the layout, and the type and size of each speaker.

The 861 Reference Digital Surround Controller can support up to 8
loudspeakers.

To specify the speaker layout

• Click Speakers in the left-hand panel of the Meridian window.

• If necessary click the Layout tab to display the Layout page of speaker
settings:

• Specify the type of each speaker by selecting the appropriate option
from each of the drop-down menus.

As you change the options the layout illustration will change to show the
resulting layout.
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If you select a combination of options that is not supported, the other
options will be adjusted accordingly to ensure that the whole configuration

is valid.

For example, if you specify Two rears and two sides, and then select two

subwoofers, the side speakers will be removed to allow you to have the
subwoofers.

The options available for the Mains, Centre, Surrounds, and
Subwoofers drop-down menus are explained in the following sections.

Mains
Use the Mains drop-down menu to specify the size and type of the main
Speakers.

• Choose Large if your main left and right speakers are large, with good
bass performance, and you want to use them for full range

reproduction.

• Choose Small if your main left and right speakers do not have a good

bass response, or your room is large and you want to use one or more
subwoofers to handle the bass for the system.

• Choose analogue, DSP, or 96.24 DSP according to the type of each
speaker.

The following table gives recommended settings for Meridian
loudspeakers:

Loudspeaker Recommended setting

DSP5000, DSP5500, Large DSP or
DSP6000, or DSP6000C Large 96.24 DSP*

DSP5000C Small DSP or Small 96.24 DSP*

M60 Large analogue

M60C, M33, or A500 Small analogue

DSP33 Small 96.24 DSP

*96.24 versions.
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Centre
Use the Centre drop-down menus to specify which presets use the centre

speaker, and its size and type.

• From the first drop-down menu choose one of the following options:

Option Description

None If you do not have a centre speaker.

Movies only If you want to use the centre speaker for Logic and
5.1 Movie DSP presets only.

Movies and music If you want to use the centre speaker for all presets.

• From the second drop-down menu specify the type of the centre
speaker; the options are as for the main speakers.

Surrounds
Use the Surrounds drop-down menus to specify the number and type of
the surround speakers.

• From the first drop-down menu specify the number of rear speakers and
side speakers you have in your surround system.

• Use the Sides and Rears drop-down menus to specify the types of the
rear and side speakers.

Subwoofers
Use the Subwoofers drop-down menus to specify the number of

subwoofers, and the DSP presets that use them.

If your main left and right speakers are small you will need to use one or

more subwoofers to handle the bass. You can choose between appropriate
combinations of mono (front), centre, left and right, or surround.

If your main left and right speakers are large you can use one or more
subwoofers to augment the bass from the centre channel. With 5.1 sources
an additional option is to use the subwoofer only for the LFE channel.

You can specify a different subwoofer configuration for Music, Logic, and
5.1 Movie DSP presets.

The Advanced checkbox is for dealer use only, and it is recommended that
you leave this unchecked unless you have special requirements.
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To specify the speaker sizes

• Once you have specified the speaker layout for your system, click the
Sizes tab to display the Sizes page of speaker settings:

This allows you to set up speaker protection for the 5.1 sources, the type of

each subwoofer, and peak-level limiting.

Speaker protection
Because of the high bass levels that 5.1 materials are capable of
reproducing, the Digital Surround Controller allows you to set up
automatic protection of each full-range speaker or subwoofer.

A setting of Max corresponds to no protection, and 0 corresponds to full
protection. By default any Meridian DSP loudspeakers in your system are

set to Max, as these include built-in protection.
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You can use SizeCalc to help you calculate the correct value for your
speakers:

• Click the Size calculator button to display the SizeCalc window:

• Specify the number of bass units in each speaker (woofers), the size of
each unit, and the design of the speaker.

The size value is displayed in the SizeCalc display.

• Type the size into the appropriate field.

If you prefer you can copy and paste the size directly.

Subwoofer filtering and type
For each subwoofer in the system you can specify the subwoofer filtering,

and its type.

• Specify the filtering from the following options:

Option Description

Narrow The Digital Surround Controller provides a low-pass cut off; the
subwoofer’s crossover should be bypassed. This is the
recommended option.

Wide The subwoofer includes a crossover.

• Specify the type of subwoofer as Analogue or DSP.

Peak-level limiting
The Max SPL or Bass limit parameter allows you to set up peak-level

limiting for bass signals, and the setting applies to all the discrete digital
DSP presets.

If your loudspeaker layout includes one or more subwoofers the parameter
is named Max SPL, and it sets the peak-level limit for the LFE channel.



74

CONFIGURING
USING A COMPUTER

If your loudspeaker layout contains no subwoofer the parameter is named
Bass limit, and it sets the peak-level limit of the bass signal added to the

main loudspeakers. For loudspeaker layouts using Meridian DSP
loudspeakers as the main left and right, or centre speakers, the Bass limit
value is fixed at -11dBFS and you cannot adjust it.

To complete the speaker setup

You have now completed the first stage of setting up the Digital Surround
Controller, and you should save the changes you have made by choosing

Save from the File menu.

You can ignore the Distances, Crossovers, Precision, Phase/Gain, and

Connection pages of settings for the moment; these will allow you to
check the values you have set up when you calibrate the Digital Surround
Controller.
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Setting up sources

This section describes how to use the Meridian Configuration program to

configure the sources provided by the Digital Surround Controller.

To set up sources

• Click the Sources icon in the left-hand panel of the Meridian window.

The right-hand panel shows a list of the 12 sources that are available. For
each source you can display four pages of settings by clicking on the

Options, Audio, Video, or Advanced tabs.

To configure the source options

• Select the source in the list of sources.

• Click the Options tab.

• Select Source exists if you want to use this source.

Disabling this options prevents the source from appearing when you press

the Source key, or the corresponding source key on the Meridian System
Remote.
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• If you want, you can change the name displayed when the source is
selected by editing the Name field.

The name can consist of up to five letters, digits, or the characters space,
full-stop, and minus. The name you specify is shown in the list of sources,

followed by the Meridian System Remote key used to select the source in
brackets.

• In the Preset section specify the DSP preset you want to use for each of
the five alternative audio formats: PCM, Dolby Digital, MPEG, DTS, or
MLP.

Each drop-down menu gives the built-in and user-defined DSP presets
appropriate for that audio format.

To specify the audio connections

• Click the Audio tab to show the connections for the audio inputs.

• Select the card in the Card list to specify the location of the connector
used for the source.

• From the Input on card drop-down menu specify the digital or
analogue audio input you want to use for the source, or Last valid to

leave the input unchanged when you select the source.
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You can create a source with Input on card set to Last valid if you want
it to change some other aspect of the current source, such as its DSP preset,
without changing the selected input.

If you have specified a digital input for the main audio input:

• Specify the precision for the source by choosing an option from the
Precision drop-down menu.

All CDs and laserdiscs are currently 16 bits. The 800 DVD/CD Player provides
24 bits. If in doubt choose 24-bit.

If you have chosen an analogue input for the main audio input:

• Specify the sensitivity of the input by choosing an appropriate option
from the Sensitivity drop-down menu.

Note that you can also adjust the sensitivity of any analogue source
interactively, using Gain/Sub mode. See To adjust the sensitivity of a source,
page 57.

To specify the video connections

• Click the Video tab to show the connections for the video inputs.
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• Select the card in the Card list to specify the location of the connector
used for the source.

• From the Input on card drop-down menu specify the video input you
want to use for the source, or Last valid to leave the video input

unchanged when you select the source.

You would usually set Input on card to Last valid for audio sources such

as CD, Radio, Tape1, and Tape2.

To set the advanced source options

• Click the Advanced tab to show the Advanced page of settings.

• If the source is a Meridian product set Comms type to 1C for a CD

player, 2C for an FM tuner, and 3C for a DVD player. Otherwise set it to
none.

• If you have two Meridian source units of the same type you can
configure them to have different Comms addresses. You can then select
the appropriate source by specifying its Comms address in the Comms
address field.
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Option Description

30ms delay for audio sources Avoids the noise caused by switching to a DTS
to avoid DTS noise (DTS delay) source. Should not be selected for video sources as it will

cause the sound to be out of sync with the picture.

Only ever play DTS for this source Creates a video DTS source that will avoid any DTS noise
when switching audio formats.

Number of frames of delay to Adds a delay required by certain video systems.
apply to audio

Poor digital audio source – Select this if you have difficulty locking to the
frequency out of range source.

Source uses validity flag properly May reduce switching noise on certain sources where
this is a problem; should be left unchecked unless
advised otherwise.

• Select any of Triggers 1, 2, or 3 to activate the specified trigger outputs
when this source is selected.

The following additional options are available. You should only change
these with advice from your dealer:
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Configuring presets

The 861 Reference Digital Surround Controller provides 21 built-in presets

and the Meridian Configuration program lets you configure the DSP
parameters of any of the built-in presets to suit your own preferences.

You can also create up to 12 additional user-defined presets. Each user-
defined preset is based on one of the built-in presets, and can have any
name of your choice.

To set up presets

• Click the Presets icon in the left-hand panel of the Meridian window.

The right-hand panel shows a list of the 21 built-in presets, and the 12
unused user-defined presets.

To modify a built-in preset

• Select the preset in the list of presets.

The default DSP parameters will be displayed:

• Adjust the parameters as required.
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Note that the treble and bass settings will not be available if your system
includes DSP loudspeakers, because in this case the DSP speakers handle the
treble and bass adjustments.

For more information about the DSP parameters available for each DSP
preset see DSP presets, page 35.

If you have modified the DSP parameters from their defaults, (modified) is
displayed after the preset name in the list of presets.

To restore the DSP parameters to their defaults

• Select the preset in the list of presets.

• Click the Reset to default button.

To create a user-defined preset

• Select the preset you want to use as the basis for the user-defined
preset.

• Click the Copy as new preset button.

The new preset is created in the first available space after the built-in
presets.

• Select the new preset you have created.

• Edit the preset name to identify the preset.
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Initially the name is set to be the same as the built-in DSP preset it was
based on, but you can chose any name of up to 8 letters, digits, or the

characters space, full-stop, or minus; eg Football.

To delete a user-defined preset

• Select the preset in the list of presets.

• Click the Delete this preset button.

To copy a preset to a specific position in the list of
user-defined presets

• Highlight the preset you want to copy.

• Choose Copy from the Edit menu, or click the
Copy button in the toolbar:

• Highlight the user-defined preset or empty position you want to replace.

• Choose Paste from the Edit menu, or click
the Paste button in the toolbar:
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Configuring cards

The Cards panel displays information about each of the cards in the

product, and lets you change to configuration of a card, and add or remove
cards.

You will normally only need to use this panel if you upgrade the 861
Reference Digital Surround Controller by adding a new card.

To set up cards

• Click the Cards icon in the left-hand panel of the Meridian window.

The right-hand panel shows a list of the cards fitted to the product, and

allows you to add cards or remove cards.

Note that after adding or removing cards, New or Missing will be shown

in the Status column. The Digital Surround Controller will still function
correctly, and the status will be updated when you next reset its
configuration to one of the standard or user-defined types; see Choosing a

standard setting, page 48.
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To change the address for a card

If you have fitted two cards of the same type you will need to assign a
different address to each card to identify them.

• Double-click the card in the Card column.

The Card properties dialogue box shows the card’s current setting:

• Select the address you want to use and click the OK button.
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Changing the setup options

The final stage in editing the settings is to configure the general Setup
options.

To change the setup options

• Click the Setup icon in the left-hand panel of the Meridian window.

• If necessary click the Setup tab to display the Setup page of options:

The Setup options will be displayed:

The options are described in the following table:

Option What it means

Lock settings on product Locks the parameters.

Contrast and Brightness Set the default brightness and contrast for the front-
panel display.

On-screen display position Specifies the default position of the on-screen display.

Tape card Specifies the level for each of the two tape outputs and
the headphone output available on the optional Tape
Card.
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Option What it means

Multi-room displays Includes displays of information from Meridian sources;
eg CD track number or FM tuner frequency.

Diagnostic displays Includes diagnostic displays in the display options.

Meridian 800 present If selected, the menu keys on the Meridian System
Remote operate the DVD/CD Player menus rather than
the Digital Surround Controller menus.

Disable VS10 On-Screen Display Select this if you are using a VS10 Video Card with a
VS00 card for S-video to composite conversion.

Volume on startup Specifies the startup volume; only available for
analogue speakers.

Comms controller status Specifies whether the Digital Surround Controller is
controller, not controller, or set automatically.

System and Copy address For multi-room setups.

Meridian High Resolution If the 861 is Meridian High Resolution compatible, and
the left, right, and centre speakers are 96.24 DSP types,
specifies whether the digital output uses Meridian High
Resolution for all sources, or only when necessary.

To change the advanced setup options

Additional setup options are provided on the Advanced page.

• Click the Advanced tab to display the advanced options.

The options are described in the following table:
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Calibrating the settings with your
system

Once you have edited the settings to suit the configuration of your system,
the next step is to store the settings to the Digital Surround Controller and
use the calibration listening tests built into the 861 to calibrate it for
optimum performance.

Alternatively to omit this step proceed to Creating a User Type, page 89.

To save the settings

First save the settings to your PC hard disk.

• Choose Save from the File menu, or click the
Save button in the toolbar:

To print a summary of settings

At this stage it is useful to print a summary of the speaker and source
settings, so that you can check that they correspond to your system
configuration.

• Check that there is a printer connected to your PC.

• Click the Settings icon in the left-hand panel of the Meridian window.

• Click the Print sources and output summary button.

To store the settings to the Digital Surround Controller

• Switch on the 861 Reference Digital Surround Controller, and check that
the serial cable is connected between the Digital Surround Controller
and the PC.

• Click the Store button in the toolbar.

The Digital Surround Controller
will display: Receiving Data...

The following Progress dialogue box shows how the operation is
progressing.
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If there is a problem click the Details button to see more information
about the problem.

When the download is complete the Digital Surround Controller will
automatically reset itself to use the new settings, and show the owner

name you defined:

For example: Zachary Ford

To calibrate the loudspeakers

Now proceed through the calibration procedure to set the correct relative
level, delay, and phase for each of the loudspeakers in the system. See

Calibration tests, page 53.

To adjust the sources

The second calibration stage involves adjusting the sensitivity of the

analogue sources; see Setting up sources, page 57.

To fetch the calibrated settings

Finally fetch the calibrated settings back from the Digital Surround

Controller as follows:

• Make sure your settings file is loaded into the Meridian Configuration

program.

• Click the Fetch button in the toolbar.

The Progress dialogue box will show you the progress as the settings are
fetched:

You can verify that the source adjustments you made are now included in
the settings by checking the Audio page of the Sources settings option.
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Creating a User Type

Once you have fetched the calibrated settings from the Digital Surround
Controller, the final step is to store them permanently to the product as a
User Type, so that you can reset the unit to them whenever you need to.

When you store one or more User Types to the Digital Surround Controller
they become available in the list of Types, alongside the built-in Types. For
more information about selecting one of the Types see Choosing a
standard setting, page 48.

To name the User Type

• Click the Settings icon in the left-hand panel of the Meridian window:

• Enter a suitable name in the Type name field to identify your User
Type, such as Standard.

The name can have up to 12 characters.

To create additional User Types

If you wish you can create several User Types, and store them all to the
Digital Surround Controller. You can then reset the Digital Surround
Controller to any of the User Types by selecting the appropriate Type
name.

To create a new User Type:

• Select the User Type you want to base it on in the left-hand panel of the
Meridian Setup window; eg Standard.
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• Click the Copy as new user type button.

The new User Type will be specified as In use, as identified by the
circle icon in the left-hand panel of the Meridian window:

Initially the new type will be created with the same settings as the type you
based it on, and with the name New type:

You can then change the name of the new Type, and configure its settings,

in exactly the same way as for the original Type.

A suggested naming convention is to name User Types with the date they

were created: for example, 06/05/98.

To copy settings between User Types

• Highlight the User Type you want to copy the settings from.

• Choose Copy from the Edit menu, or click
the Copy button in the toolbar:

• Highlight the User Type you want to copy the settings to.

• Choose Paste from the Edit menu, or click the
Paste button in the toolbar:

You can also copy and paste source and preset settings from one section of
a user type to the same section of another user type as follows:

• Highlight the icon corresponding to the section of settings you want to
copy: Sources, Presets, or Cards.
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• Choose Copy from the Edit menu, or click the
Copy button in the toolbar:

• Highlight the same icon in the User Type you want to copy to.

• Choose Paste from the Edit menu, or click the
Paste button in the toolbar:
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Completing the configuration

The final stage in creating a settings file is to save it, and then store it to
the Digital Surround Controller.

To save the current settings

• Choose Save from the File menu or click the Save
toolbar button, to save the changes you have made
to the settings file to your PC hard disk.

To store the settings to the Digital Surround
Controller.

• Click the Store button.

The settings will then be downloaded
to the product, and the display shows:  Receiving Data...

As the download proceeds the following dialogue box shows its progress:

If the download was successful the product will briefly display the owner
name you have defined;

For example: Zachary Ford

It will then switch itself to standby.

The User Type you have created will now be available in addition to the
built-in Types, and will be selected by default if you need to reset the
configuration of the Digital Surround Controller; see Choosing a standard
setting, page 48.
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Absolute phase

A control which changes the phase of the signals to all the speakers.

AC-3

An alternative name for the Dolby Digital format.

Ambisonic

A music encoding and decoding system designed to recreate the original

soundfield using an array of loudspeakers.

Aspect ratio

The overall shape of the speaker layout.

Compress

A DSP parameter providing dynamic range control for Dolby Digital
sources.

Controller

The product in a Meridian system that uses the infra-red signals from the
remote to control the system. The controller is normally chosen

automatically, but the installer can override this.

Dolby Digital

A digital surround-sound which provides five full-frequency range channels

(left, centre, right, left surround, and right surround) and an additional
Low Frequency Effects (LFE) channel which is band limited to 120Hz.

Dolby Surround

The encoding system used for the majority of movies on video and many TV
broadcasts. Dolby Surround encoded material can be replayed with a
surround decoder connected to an array of loudspeakers which normally

include at least left, centre, right, and rear surround.

DTS

Digital Theatre Systems originally produced digital audio tracks for motion

pictures. A version of this format adapted for consumer video and audio
products is referred to as DTS Entertainment. Like Dolby Digital it provides
five full-frequency range channels (left, centre, right, left surround, and

right surround) and an additional Low Frequency Effects (LFE) channel.
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DVD

Digital Video Disc or Digital Versatile Disc, a versatile CD-sized disc with
nearly 30 times the storage capacity of CD. It is capable of storing digital

video, high-quality multi-channel audio, or computer data.

Layout

Refers to a particular arrangement of speakers and subwoofers. You can

select different layouts for the Logic, Music, and 5.1 Movie DSP presets.

LFE

The Low Frequency Effects (LFE) channel which enhances movie

soundtracks with sound effects and ambient sounds. It is band limited to
120Hz in a Dolby Digital system.

LFE sub

A subwoofer which, in addition to any bass which it handles from the main
channels, plays the full 120Hz bandwidth LFE signal in Dolby Digital, DTS,
and MPEG presets.

Limit

A DSP parameter that sets the peak-level limit of the bass signal added to
the main loudspeakers.

Max SPL

A DSP parameter that sets the peak-level limit for the LFE channel.

Menus

The flexible system for choosing options and configuring settings in
Meridian products. On the 861 the menus are controlled by the <, >, A,
and V keys under the front panel or on the MSR.

MHR

Meridian High Resolution is a proprietary secure encoding format using
encryption and anti-copy methods that allows secure transfer of audio

streams between elements of a Meridian-only system for the purpose of
playback only. It provides a secure copyright protection environment and
has the very important benefit of lowering jitter and improving sound

quality on all material.

MLP

MLP (Meridian Lossless Packing) is an audio format that increases the

amount of information that can be recorded on a CD or DVD, without any
loss of quality.
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Mono sub

A subwoofer which handles all the bass for the system. A THX standard
subwoofer has a crossover at 80Hz.

Mono surrounds

Surrounds which have a common signal steered to them. This may then be
decorrelated by the THX process to give more spaciousness.

MPEG

MPEG Surround is a digital encoding system developed by the Motion
Picture Expert Group. Like Dolby Digital it provides five full-frequency
range channels and an additional Low Frequency Effects (LFE) channel.

MSF

Meridian Settings File, a file containing settings and User Types for one or
more Meridian products.

MSR

The Meridian System Remote, or handset.

OSD

On-Screen Display, which the 861 can superimpose on a composite video
signal to give information about the state of the system, and to help
during configuration.

PCM

Pulse Code Modulation, the method used to encode music digitally, as used
on audio CDs.

Preset

A DSP decoding option in the 861. You can create user-defined presets
based on the built-in presets, and with specific parameter values; see
Defining your own presets, page 33.

Source

An input to the system, such as CD or TV. The Meridian 500 and 800 Series
provide 12 named sources, corresponding to the names of the 12 source
keys on the MSR. In the 861 you can choose the logo displayed for each
source, and the input used for it.
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SPL

Sound Pressure Level, a physical measurement of the level of sound at a
particular location which can be obtained using an SPL meter.

Steered surrounds

Surrounds which have individual signals steered to them by the Digital
Surround Controller’s steering matrix.

Surround

A sound reproducing system with more than two loudspeakers, and usually
with speakers behind or to the side of the listener.

THX

Additional processing that follows Dolby Pro Logic Surround decoding to
give a more faithful reproduction of cinema sound in the home.

Trifield

A music decoding system designed to extract centre and surround signals
from a conventional two-channel stereo source.

Type

A standard configuration of the Digital Surround Controller. Selecting a
Type resets any configuration and calibration changes to either a factory

default, or a stored set of user settings.
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Index

A

AC-3 3
Academy (DSP parameter) 6, 38
accessories
Tape card 21
Ambisonic DSP preset 4, 40
analogue sources, adjusting
sensitivity 57
audio connections, setting up
using a PC 76
audio formats 17

B

Balance (DSP parameter) 25, 28
Bass (DSP parameter) 25, 27
bass, changing 27
brightness, display 18
built-in presets, replacing 33

C

calibration procedure 47
exiting 52
starting 51

calibration tests 53
Distance 54
fine tuning 55

Levels 53
cards
changing address 84

setting up using a PC 83
Cards icon 62
Centre (DSP parameter) 25, 29, 40
centre speaker
changing the relative delay 29
changing the relative level 29

changing the DSP parameters 25
clearing user-defined presets 34
clip indicator 58
Compress (DSP parameter) 44
compression 44
configuration
using a computer 61
without a computer 47

configuration, resetting 48
contrast, display 18
Copy options 21
copying a source 21
copying settings between user
types 90
crossover frequency, adjusting 58
customising the Digital Surround
Controller 23

D

defining your own DSP presets 33
Depth (DSP parameter) 25, 29
diagnostic displays 86
digital formats 3
AC-3 3
Dolby Digital 3

DTS 3
MPEG Surround 3
THX 4

Digital Signal Processing 2
Direct DSP preset 6, 42
display
brightness 18
changing 18
contrast 18

information 19
on-screen 19
Distance (calibration test) 54, 55
Dolby Digital DSP preset 43
dynamic range control 44
Dolby Digital encoding 3
Dolby Digital THX DSP preset 43
Dolby Digital THX encoding 4
Dolby Surround encoding 4
DSP 2
DSP parameters
changing 25, 26

saving 33
standard 25
DSP presets 3, 35
Ambisonic 40
assigning to a source 32
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DSP presets (continued)
changing 17

clearing 34
configuring using a PC 80, 83
defining 33

Direct 42
Dolby Digital 43
Dolby Digital THX 43

DTS 43
DTS Music 42
DTS THX 43

editing name 33
modifying a built-in preset using a PC 80
MPEG 43

MPEG Music 42
MPEG THX 43
multi-channel 45

Music 39
MusicLogic 41
selecting 17

Stereo 42
Super Stereo 41
Trifield 39

DTS DSP preset 43
DTS encoding 3
DTS Music DSP preset 42
DTS THX DSP preset 43
DTS THX encoding 4
dynamic range control 44

F

fetching calibrated settings 88
5.1 Movie DSP presets 43
front panel keys 12

G

Gain/Sub mode 57
glossary 93

H

headphone volume 21
HS Out? (DSP parameter) 40, 42

I

Input (DSP parameter) 38
installing the Meridian
Configuration program 63

L

Levels (calibration test) 53
LFE (DSP parameter) 44
Limit (DSP parameter) 44, 45
lip sync
changing 31

description 31
LipSync (DSP parameter) 25, 31
listening position, changing 28
locking the menus 24
Logic DSP presets 36
loudspeakers
setting up using a PC 69
specifying layout using a PC 69
specifying the sizes using a PC 72

M

Max SPL (DSP parameter) 44, 45
menus
locking 24

unlocking 24
Meridian Configuration program 62
installation 63

requirements 63
running 64
toolbar buttons 64

Meridian High Resolution (MHR) 86
Meridian System Remote keys 13
MLP (Meridian Lossless Packing) 4
Mono preset 6, 38
Mono Rear (DSP parameter) 37, 38, 41
moving the listening position 28
MPEG DSP preset 43
MPEG Music DSP preset 42
MPEG Surround encoding 3
MPEG THX DSP preset 43
MPEG THX encoding 4
multi-channel digital formats 3, 45
Music DSP preset 5, 39
Music DSP presets 39
MusicLogic DSP preset 5, 41
muting the sound 16

O

on-screen display 19
position 19, 31

Options (View menu) 65
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Options dialogue box 65
OSD (DSP parameter) 25, 31
Owner icon 67

P

Party? (DSP parameter) 6, 38
PC, using to configure the 800 61
peak-level limiting 45, 73
personal details, entering using
a PC 67
Phase (calibration test) 55
Phase (DSP parameter) 25, 27
phase, changing 27
Position (DSP parameter) 41
presets
Ambisonic 4

Direct 6
Dolby Digital 3
Dolby Digital THX 4

DTS 3
DTS THX 4
Mono 6, 38

MPEG 3
MPEG THX 4
Music 5

MusicLogic 5
Pro Logic 36
Stereo 6

Super Stereo 5
THX Cinema 4, 37
Trifield 5

TV Logic 4, 37
Presets icon 80
Pro Logic DSP preset 4, 36

R

R Delay (DSP parameter) 25, 30
R Filter (DSP parameter) 40, 41
Rear (DSP parameter) 25, 28
rear speakers
changing the relative delay 30
changing the relative level 28

recording
a source 21
from a television 21

resetting the configuration 48
return to top level icon 67

Roll (DSP parameter) 38, 41

S

S Delay (DSP parameter) 25, 30
S Filter (DSP parameter) 40, 41
Save As (File menu) 66
selecting a source 15
serial cable, connecting 65
serial port, specifying 65
settings file, creating 66
Settings icon 67, 68
Setup icon 62, 85
Setup options, using a PC 85
side speakers
changing the relative delay 30
changing the relative level 28

Sides (DSP parameter) 25, 28
sinewave sweep test 59
SizeCalc 73
sound, muting 16
Sound Pressure Level meter 51
sources 15
adjusting sensitivity of analogue 57
assigning DSP preset 32
changing DSP preset 32

configuring options using a PC 75
default DSP preset 17
recording 21

selecting 15
setting advanced options using a PC 78
setting up 57

setting up using a PC 75
specifying connections using a PC 76
Sources icon 62, 75
spaciousness of the sound,
changing 30
speakers
setting up using a PC 69
specifying layout using a PC 69
specifying sizes using a PC 72

specification 9
standard DSP parameters 25
standard settings, selecting 48
standby, switching to 14
Stereo DSP preset 6, 42
storing settings 87
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subwoofers, setting crossover
frequency 58
Super Stereo DSP preset 5, 41
Surr. Rear (DSP parameter) 40, 44
switching on and off 14

T

Tape card 21
technical overview 7
television, recording from 21
THX Cinema DSP preset 4, 37
THX encoding 4
THX level 53
time-aligning the system 54
toolbar buttons 64
Treble (DSP parameter) 25, 27
treble, changing 27
Trifield DSP preset 5, 39
TV Logic DSP preset 4, 37
two-channel formats 4
Ambisonic 4
Dolby Surround 4

Pro Logic 4
Types 48

U

UHJ format 40
unlocking the menus 24
User Types
copying settings between 90
creating 89

naming 89
user-defined presets 33
clearing 34

creating 81
deleting 82
editing name 33

V

volume
adjusting 16
headphone 21

W

Width (DSP parameter) 40

Y

Yaw (DSP parameter) 38, 41
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